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1 Introduction

1.1 About Likno Web Button Maker

 

Likno Web Button Maker is a user-friendly software for creating unique and professional custom 3D
web buttons for your web pages and projects fast and easy.

With this innovative program you can design and create an endless variety of stylish 3D website
buttons with different effects, backgrounds, and text options by customizing their dimension, text, size,
shadow, lighting, texture, shape and more. You can choose from a range of pre-defined shapes and
styles of web buttons offered in the program ranging from plastic to metallic, or simply customize your
own buttons by applying a variety of different custom features and effects to them. 

Impress your web site visitors by displaying unique navigation buttons on your html pages, or simply
transform your projects by applying stylish web buttons to them. 

Guide your users to the desired "click" by creating attractive buttons with our web button generator. 

1.2 Why Choose Likno Web Button Maker?

Likno Web Button Maker uses a user-friendly interface that makes creating custom 3D web buttons
a fun and easy task! 

This program helps you create stylish 3D website buttons in just minutes - no previous experience
needed!

All you need is to select the different effects, backgrounds, and text options you want your buttons to
have as well as define their dimension, text, size, shadow, lighting, texture, shape with a simple click of
a button!

You can choose from a range of pre-defined shapes and web button material offered in the program
ranging from plastic to metallic, or simply customize your own buttons by creating your own templates
and applying a variety of different custom features and effects to them.
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There are no limits as to what you can create with Likno Web Button Maker. Guide your users to the
desired "click" by making attractive 3d buttons with this 3d web button generator.

For more information about the program and its features please visit the Likno Web Button Maker
home page  

1.3 Activating Likno Web Button Maker

 
The Likno Web Button Maker unregistered version is fully functional in its web button design
capabilities but is limited by a watermark seal found on each web button design. 

Purchasing Likno Web Button Maker entitles you to:

·  Export and add your web buttons to your web pages without the intrusive watermark found in the
trial version.

·  Priority based customer support. 

Apart from the features above you also get benefits such as:

·  Reliability:  Accumulated expertise in our application development.  
·  Upgrades: All minor updates of the program are for free.
·  Support: Quick and thorough answers from our dedicated support team plus detailed

documentation.  

Not to mention that you would be contributing to Likno Web Button Maker's growth as the
registration fee is invested in the rapid development of Likno Web Button Maker. More powerful
features will be available to you.  

To obtain a registered Likno Web Button Maker license please follow the following steps:

  Step 1. Purchase Likno Web Button Maker online

To purchase Likno Web Button Maker:

· Access the online registration page located at http://www.likno.com/web-button-maker/register.php

· Enter the required information in the order form and click on your preferred method of payment

· Submit the registration form

· You will receive an e-mail with a link containing instructions on how to obtain your Registration
Information (Registration Information page).

 
Payment Methods:

There are many flexible payment options: 

· Credit Card Orders (all major credit cards accepted)  

http://www.likno.com/web-button-maker/index.html
http://www.likno.com/web-button-maker/index.html
http://www.likno.com/web-button-maker/register.php
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· PayPal Orders
 
· Phone Orders (toll-free)  
 
· Mail Orders (pay by check)  
 
· Fax Orders  
 
· Purchase Orders  
 
All on-line transactions are protected by an extremely high level of encryption, the highest allowed by
U.S. law. 

  Step 2. Activate your application

 To activate Likno Web Button Maker: 

· Install and run the Likno Web Button Maker application (after installation double click on the shortcut
on your desktop) 

· Go to HELP -> About Likno Web Button Maker 

· Click on the  "Register Now"  button 

· Double-click inside the Installation ID text box to select the Installation ID from the Registration
dialog 

· Press [Ctrl]+C or right click and select "Copy" from the menu 

· Go to the e-mail you received with instructions on how to obtain your Registration Information, click
on the link to open the Registration Information page and paste the Installation ID on the relevant
text area provided

· Click on the  "Get Activation Code" button

· Go back to the Registration dialog (in the application) and enter the User Name and Activation
Code 

· Click on the  "OK"  button to complete the activation process

1.4 System Requirements

To install and use Likno Web Button Maker you will need the following system requirements: 

· Windows 98, Me, NT 4.0, 2000, XP or later version  
· 400 MHz processor 
· 64 MB RAM (128 MB recommended)  
· 20 MB of hard-disk space for program installation 
· DirectX 8.1 or above
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1.5 Keyboard Shortcuts

In order to have access to the different actions in a quick and easy way you can use the following
keyboard shortcuts:

· New :    Ctrl + N

· Open:    Ctrl + O

· Save:    Ctrl + S

· Undo:    Ctrl + Z

· Redo:    Ctrl + Y
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2 Tabs

2.1 Web Button Dimensions

Likno Web Button Maker lets you edit the dimension of your web button in order to customize it to
your web page, project or other needs.

To adapt your web button creation to specific values and edit its dimensions you need to:

· Click on the control panel "Dimensions" tab   

In this area you can define the width, height, constrain proportions, and margins of the web button
accordingly.

For information on how to edit web button dimensions please refer to the related topics.

Related Topics:
Editing the dimensions and margins of your web button

2.2 Web Button Shapes

Likno Web Button Maker lets you choose from a variety of pre-defined web button shapes in order to
start creating your web button.

To select one of the pre-defined web buttons, in order to get started, you will need to:

· Click on the Control Panel "Button Shape" tab 

      

In this area you can choose a web button design from the existing selection and customize it
accordingly.

For information on how to go about creating a web button please refer to the related topics.

Related Topics:
Creating a web button

2.3 Web Button Background

Likno Web Button Maker lets you edit the background you wish your web button to have.

In order to insert a background to your web button you need to:

· Click on the "Background" tab 

19

14
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In this area you can select the background image you wish to add to your web button and customize it
accordingly. You may adapt the background by defining its position as tile, stretched or centered,
visible or not, and finally you can also define the background color.

For information on how to add web button background please refer to the related topics.

Related Topics:
Adding background to your web button

2.4 Web Button Material

Likno Web Button Maker lets you add and edit the material that you want your web button to have.

In order to add a plastic, metallic or your own customized style of material to your web buttons you will
need to:

· Click on the "Button Material" tab 

    

In this area you can select and customize material such as the Mesh Segment, Color, Reflection and
Texture you wish to apply to your web button in order to give it the look that best suits your web page,
project, etc.

For information on how to add web button material please refer to the related topics.

Related Topics:
Defining the material of your web button

2.5 Web Button Lights

Likno Web Button Maker allows you to add light effects to your web buttons. You can choose from up
to 4 lights in order for you to have more lighting options to customize your web buttons with. 

To add and customize the light color and intensity of your web buttons you will need to:

· Click on the "Button Lights" tab 

   

In tis area you can customize the color , effect and intensity for each of the lights you have enabled.

For information on how to add web button lights please refer to the related topics.

21

21
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Related Topics:
Adding light effects to your web button

2.6 Web Button Shadow

Likno Web Button Maker lets you add shadow effects to your web buttons in a simple manner.

To add shadow effect to your web button you will need to:

· Click on the "Button Shadow" tab 

   

In this area you can edit and customize the position, color, spread and opacity of the shadow you want
to apply to your web button.

For information on how to add web button shadow please refer to the related topics.

Related Topics:
Adding shadow to your web button

2.7 Web Button Text

Likno Web Button Maker lets you add text to your web buttons in order for you to be able to
customize your web buttons to your specific needs. 

To add text and text shadow to your web button you need to:

· Click on the "Text" tab 

In this area you can define the text you want to add to your web button as well as edit the font, bold
and italic features and color. Finally you can also customize the horizontal and vertical positioning of
the text shadow as well as its color, spread and opacity.

For information on how to add web button text please refer to the related topics.

Related Topics:
Editing web button text

2.8 Web Button Text Actions

Likno Web Button Maker lets you define and edit the text actions of the text you have added to your
web buttons.

25

27

28
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To edit the text actions of your web button you need to:

· Click on the "Text Actions" tab 

   

In this area you can edit the Rotation, Extrusion, Color, Orthogonal Projection, and Position of the text
that you have added to your web button.

For information on how to edit web button text actions please refer to the related topics.

Related Topics:
Editing text actions

2.9 Web Button Links

Likno Web Button Maker allows you to add a link to your web buttons.

To add a link to your web button you need to:

· Click on the "Links" tab 

   

In this area you will be able to define the link and link target that you want to associate to each button
separately.

For information on how to add links to your web button refer to the related topics.

Related Topics:
Adding Links to Web Buttons

37

49
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3 Actions

3.1 Creating a web button

To design your own template and create a new web button all together first click on File ->New from
the Main Menu

Then select a pre-defined web button from the selection found at the Button Shape tab .

Finally edit and/or add changes you want to your web buttons. Some feature are:

Dimensions and Margins
Background
Material
Lights
Shadow
Text
Text Actions
Export
Rollover Effect

3.2 Selecting a Shape-Preset

You can create a web button based on available Button Shapes and Presets found in the application.

Shapes

To select a Shape Click on the Button Shape tab  and choose the Shape you want from the display:

8

19

21

21

25

27

28

37

42

38

8
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You can then edit and customize the button (dimensions , lights , material , text , etc.)
based on the specific Shape you have selected

Presets

Presets are web buttons that have pre-defined colors, dimensions , lights , material , text ,
etc.

In order to load presets select the specific button shape you want and you will be provided with a
selection of presets that have been adapted to that specific Shape.

Example Presets:

Example 1

Example 2

19 25 21 28

19 25 21 28
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If you have loaded a preset and edited it, you must save it before loading another. If you load a second
preset the pre-defined parameters of the second one will override the parameters of the first one
except for the background, dimensions, margins, text content, text size, text bold/italic and
button shadow. 

Example of the results of your web button when selecting a second preset:

First Button Preset Selection:

Result of first Button With second Button Preset Selection:

Preset View

Preview Option 1:

You can select to view the existing Presets based on each shape individually. 
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Preview Option 2:

You can select to view the entire existing Preset collection across shapes. 
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Get More Shapes

Purchasing Likno Web Button Maker entitles you to a series of shapes found in the program (Button
Shape tab) which can be used to create your buttons plus a FREE Button Pack made up of 5
completely new shapes and presets, plus a series of ready-to-use web buttons!

You can also download and purchase additional Button Packs with premium web button designs in
order to enhance your existing collection!

Button Packs are a complete solution for your web button creation needs!

You can download Button Packs and get more shapes by clicking on the "Get More Shapes Online"
button found at the end of the shape display in the Button Shape Tab.
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3.3 Editing the dimensions and margins of your web button

To create your web button you might need to define the specific dimensions it needs to have in order
for it to adapt to your needs. (for example when creating navigation bar buttons)

To edit the dimensions of your web button you must first click on the Dimensions tab .

Width and Height
 
The dimension elements that you can edit are the width and height of your web button as well as if you
would like to activate the constrain proportions.

Simply define the dimension values that you want to add to your web button and click on the "Apply" or
the "Enter" (keyboard) button. 

8
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The Standard Sizes options are based on the Interactive Advertising Bureau standards.  

The final image produced by the application will have the dimension values you have given. The button
will be included within the image. The button within the image can be smaller if you define non-zero
margin values.

You will automatically be able to see the result in the preview window.

Margins

To define the values of the margins of your web button and adapt it to the your needs, go to the 
"Dimensions" tab and define the upper, lower, left and right margin segments of your web button.
Define the margin values that you want your web button to have and click on the "Apply" or the "Enter"
(keyboard) button.

Margin values will define the area inside the image where the actual button will be displayed. In other
words, the margins do not change the dimensions  of the image, but rather the size of the button
itself. 

Example 1: (margin value of 0)

Example 2: (margin value of 10)

19
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The dimensions used in the above images are equal, however the second example image shows the
corresponding changes made to the margin values. 

You will then automatically be able to see the result in the preview window.

3.4 Adding a background to your web button

You can add a background image to your web button in order to give it a specific look (for example
adapted to your web page). 

To add a background to your web button you must first click on the Background tab .

To enable the use of background on your web button all you need to do is click on the "Choose"
button and select the background image you want to apply to your web button. It will then automatically
be set as background on your web button. Finally, you can also define its position as tile, stretched or
centered accordingly.

If you do not want to insert an image but instead want to add a color as background, do not click the
background check box and just select the color you want from the color picker to apply it accordingly.
Automatically the color you selected will be set as a background.

You can see your changes as you customize them directly through the preview window.

3.5 Defining the material of your web button

When you customize web buttons, one of the elements to be edited is the material of the web button.
According to the design of your website pages or navigation bar buttons, you might want to give it a
plastic, metallic, glassy look or your own customized style.

To add material to your web button you must first click on the Button Material tab . You will see the "
Mesh Segment", "Reflection" and "Texture" options.

8

9
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Mesh Segments

Depending on the button you have selected, it might consist of a Single Mesh Segment or more. You
can see Single and Multi Mesh Segment samples below.

Example 1  (Single Mesh Segment):

 

Example 2  (Multi Mesh Segment):

In case your button consists of more than one Mesh Segment (as in example 2) you can select the
specific segment you wish to edit (this is done through the Mesh Segment drop down menu) and
define the reflection and color you wish to add to that specific segment. 

Referring to example 2, you can see the button is made up of 2 Segments. By selecting the "0" or the
"1" from the Mesh Segment drop down menu you can edit each segment respectively.
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Reflection, Color and Texture

After selecting the Mesh Segment, you can define the reflection, color, and texture you want that
segment to have. 

The reflection refers to how the light reflects on the specific segment of the button. This reflection
gives us a view on the material. To do this you can select from the pre-defined ones, such as the
Plastic or Metallic options, or customize your own. 

To customize your own simply click on the "Edit" button, and define from the "Edit Reflection" window
the values for the Diffuse, Specular and Power options in order to give your web button the type of
reflection and look you want and would like your button to have.

The combination of the light color and the color reflected by the button gives us the resulting color of
the button.  

The material  of the button results from the combination of colors used in the Diffuse and Specular
parameters. In other words, a combination of a light color in the "Diffuse" parameter and a dark color
in the "Specular" parameter, creates a "Plastic" looking result. On the other hand, a dark color in the "
Diffuse" parameter and a light color in the "Specular" parameter, creates a "Metallic" looking result. 
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Also, by specifying the "Power" parameter which determines how intense or soft the light reflection in
the button will be, you can create different types of eye-catching and original web buttons.

The above settings take effect only when the button lights  are enabled. When all lights are
disabled, the only way to define a color for the button is by setting the color property found in this
panel. Of course, with disabled lights you will not have the reflections and shadows that give a visual
appeal to your buttons. 

Moreover, you can define the color to be applied simply by selecting the one you want from the color
picker.

Finally, you can also add "Texture" to your web button simply by checking the "Visible" button to
activate the texture option.

After you click on the "Visible" button, you are able to choose between the "Browse" and the "Gallery"
options. You can choose the "Browse" option in order to select one of your images and use it as
texture (based on its properties) or you may select one of the already existing textures found in our
gallery through the "Gallery" option. 

Example of button with selected image (Browse option)

Example of button with gallery image (Browse option)

25
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Finally, after having selected texture you can edit its properties (Emboss, Hue, Intensity, Saturation,
Contrast) and grayscale option by using accordingly the texture controls.

Automatically the relevant changes are made and you can see them directly through the preview
window.

3.6 Adding lighting to your web button

To give your web button an impressive look, one of the elements you can add are light effects. You
can use up to 4 lights to customize the look of your web button.

To add lights to your web button you must first click on the Button Lights tab .

Click on the light check boxes to activate the Diffuse Light(s) and/or Spot Light(s) (specular) you want
to use and choose the light(s) color from their respective color picker. 

The color of the light in combination with the color reflected by the material  specifies the resulting
color of the button in the area affected by the light. 

You can also define the light intensity of each light which will add the relevant effect to your web
button. 

9

21



Likno Web Button Maker User's Guide26

© 2000-2012 Likno Software

      

You can customize the effect of the combination of lights by moving accordingly the "light icon"
corresponding to the light(s) you are using.

Light Presets

After you have defined the light colors, intensity and positioning you can save the resulting light effect
as a preset.    

Simply click on the "Save new preset" button, name your preset, and click on the OK button. 
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Your preset will be added to the existing Light Preset Collection and you will be able to load it simply by
selecting it from the drop down menu.

3.7 Adding shadow to your web button

To give your web button an original look one of the effects you can add to it is shadow. You can easily
determine the look, color, and intensity of the shadow you want to add to your button.

To add shadow to your web button you must first click on the Button Shadow tab  and activate the "
Enable Button Shadow" check box. 

Define the horizontal and vertical options to edit the position or "where" the shadow will be placed
according to the button. Then, select the color you want the shadow to have from the color picker. The
most commonly selected color is the "Black" one as it is the most shadow representative. 

Finally, define the spread and opacity properties to customize the intensity and blur of the shadow
implementation in your web button. 

In order to disable the shadow effect from your button, simply deactivate the "Enable Button Shadow"
check box and all button shadows customization options will remain inoperative.

10
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Automatically the relevant changes are made and you can see them directly through the preview
window.

3.8 Editing web button text

You can add text to your web button in order to give it a specific importance and meaning as in the
case of navigation bar buttons, product offer buttons, buy now buttons, etc. By adding text, combined
to the design, you give your web button a complete and original design specified to your needs.

To add text to your web buttons you must first click on the Text tab .

Text

Enter your text in the text box and define the font, size, bold and/or italic features as well as the color
you want it to have.

If you would like to add multi-line text to your button, you can skip to the next line when writing your text
by clicking on the "Enter" button (keyboard). Moreover, you can also define the spacing between the

text lines simply by moving the Line Spacing slider accordingly.

Click on the "Apply" button when ready.

By using the "Character" option you are able to browse and select from the various characters
belonging to the different fonts. Whether its symbols, letters, numbers, etc. the "Character" option
gives you a wider range of possibilities as to the symbols and characters you can apply to your web
buttons.

Depending on the font you choose, there are different character options you can select from.

Simply select the character you want and click on the "Insert" button (keyboard) - or "Enter" Key
(keyboard) to add it to the text box. 

10
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for more information on the Character feature please refer to the Adding Characters to your Web
Button Text Topic .

Text Shadow 

You can add shadow effects to your web button text. In order to do this simply click on the " Enable
Text Shadow" button and edit its horizontal and vertical placement. Moreover, you can add color to
the shadow by choosing the one you want from the color picker and customize the text shadow blur
and intensity by defining the spread and opacity properties respectively. 

In order to disable the shadow effect from your text, simply deactivate the "Enable Text Shadow"
check box and all text shadow customization options will remain inoperative.

31
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Automatically the relevant changes are made and you can see them directly through the preview
window.

3.9 Creating a button family

A button family is a series of buttons created that have the same defined features-specifications (i.e
dimensions, shape, texture, material , etc), except for the captions-text. 

For example:

This offers you a complete solution as you can create an entire web button family based on specific
captions you define for each web button individually in a very easy and quick manner.

Simply click on the "Add Button" option in order to add a button to your button family. Then, define the
caption (text) you want your button to have and click on the "Apply" button for the changes to take
place.  You can see the changes (defined captions) for each individual button by selecting a specific
button from the drop down menu.

If you want to delete a specific button from your web button family, simply select it from the drop down
menu and click on the "Delete" button.

Exporting the web button family:

To export you web button family you are given a set of options.

First, you will need to click on the "Export" button. You will see at the bottom of the Export window the
option for exporting the entire web button family you have created:
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Check the "Export entire button family" option and select the filename option you prefer. You may use
the defined filename as prefix and automatically numbers will be added in an ascending manner (i.e
filename01.jpg, filename02.jpg, etc) or use the defined button caption adjusted accordingly for use in
websites (compatible characters)

 

3.10 Adding characters to your web button text

One way to enhance your web buttons is by adding symbols and characters to them. You can give
your buttons a special look that will make them "speak for themselves" and drive your website visitors
to the desired click!

Examples of buttons with symbols:

Contact us : 
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Next:

Search

How to add symbols to your buttons

To add symbols to your web buttons first click on the Text Tab .

By selecting the "Character" option you are able to browse and select from the various characters
belonging to the different fonts. Whether its symbols, letters, numbers, etc. the "Character" option
gives you a wider range of possibilities as to the symbols and characters you can apply to your web
buttons.

Notice that depending on the font you choose, there are different character/symbol options you can
select from.

Note: For symbols choose fonts such as Wingdings and Webdings.

Simply select the character you want and click on the "Insert" button (keyboard) - or "Enter" Key
(keyboard) to add it to the text box. 

10
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Text Actions

You can also give different effects to the symbols and characters you add to your buttons by using the
rotate, move or extrude options!

Give the symbols and characters you add to your buttons a 3D feel and impressive look.

Examples:
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Email Us:

Last:

FAQ:

3.11 Working with Button Factory

The Button Factory dialog provides a fast and fun way to create buttons without having to manually
tweak all the parameters which can be found in the various tabs of the application.

The Button Factory dialog is split into 4 areas. 

Area 1: The top left area is where you can preview your generated buttons. 

Area 2: The middle left area is where you can control how these buttons will be generated. 

Area 3: On the right area you will find the Drafts Panel.

Area 4: The bottom area contains the main buttons of the dialog which allow you to assign your
creations to the buttons in your main project or import one of your projects into the Button Factory.
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When you first enter this dialog, you will notice 9 buttons arranged in a 3x3 grid, with a button
surrounded in orange color. This button is the Core Button in the Button Factory dialog. All the other
buttons are generated based on the properties of this button, with differences which are controlled by
the checkboxes and sliders in the control area below.

When you click on the Core Button or on the "Generate" button below, a new set of buttons will be
created. Clicking on another button will make that button the Core Button and generate a new set of
buttons based on it. 

The Presets list contains sets of predefined slider values which allow you to control which parameters
will be affected in a faster way than playing with the sliders and the checkboxes above. You can even
save your own favorite Presets!

  

The checkboxes specify whether a certain parameter will be changed or not. The sliders control the
similarity of that parameter to the Core Button or the chance of that parameter to change. The lower
the slider values are (more to the left), the less visible are the differences between the Core Button and
the rest of the buttons. For example, the Shape slider specifies the chance of the Core Button's shape
to change, while the Text Color slider specifies the difference between the Core Button's text color and
the generated buttons' text color.
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The Drafts panel is used to keep buttons that you like as you go along playing with the settings. You
can add any button to the Drafts by clicking on the little green plus icon beside it, and you can assign
any buttons in your Drafts to the Core Button at any time using the blue arrow pointing to the left. You
can even save the buttons in your Drafts as regular Likno Web Button Maker projects (using the little
floppy disk icon).

Finally, once you're satisfied with the result, you can apply the Core Button properties to any of your
open projects or even to specific States. At all times, you can also make any changes you like using
the various tabs in the main application, and then import them back into the Button Factory dialog.
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3.12 Editing text actions

To define text actions you must first click on the Text Actions tab .

Text Rotation

One of the web button text actions you can edit is the rotation (positioning) of the text. Simply use the
relevant sliders to move your text based on the specified axis (around x, y, z)

Extrusion

You can edit the extrusion features first by defining the level. Then, add color to your text sides by
selecting the one you want from the color picker. You can also determine whether you want to add an
Orthogonal view (instead of a Perspective one) and/or apply a Vertical 90 degree view.

Movement

Define the position of your web button text by determining the values for the X and Y axes
respectively. 

10



Likno Web Button Maker User's Guide38

© 2000-2012 Likno Software

Automatically the relevant changes are made and you can see them directly through the preview
window.

3.13 Rollover button customization

In order to create a Rollover button, you will need to customize its Three-States (Normal State, Mouse
Over State, Mouse Click State).

To customize the Normal State, Mouse Over State, Mouse Click State features simply go to Menu ->
File -> Switch to Three-State button. 

After you switch to Three-State button you will be able to customize the Normal State, Mouse Over
State, Mouse Click State features individually or simultaneously (more than one state at the same
time). 

Example of Rollover Button

State Customization

You can edit and customize the features of each of the three states.

To customize a state individually, simply click on the specific check box and apply the changes you
wish to make to it.
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When you're working with 3-State buttons, you will notice a gray rectangle to the left of each button in
the main view. One of these rectangles will also contain a checkmark. This indicates that this State is
the Active State. Any changes you make will affect this State only. 

If you would like to make changes to more than one States at the same time, you can link these States
to the Active State by clicking inside their respective gray rectangles. Linked States are indicated by a
chain icon next to the button image. If you choose to customize more than one state simultaneously,
you need to keep in mind that the attributes will also be adopted by the other state(s). An example
would be if you have chosen 2 states and change the text in the Active State. The text you add will also
be adopted by the second state.  

 

You can change the Active State simply by clicking once inside the button image. You can unlink a
State by clicking again on the chain icon.
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The only feature that is not influenced by the number of states selected are the Dimensions  (Width
and Height). No matter how many states you have chosen 
(1, 2, or 3), if you edit the width and height the changes will take effect on all three states.

120*40 (width*height)

150*50 (width*height)

Manual Feature Editing

19
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You may manually move the button, button shadow, text, and text shadow simply by locating the
cursor on the text for example and moving it to the desired location.  

    

You can also edit manually the margins and graphic size by locating the cursor on the button borders
and moving according the margins. You will be able to see the values you have given to the margins
as you customize them.

    

   

Mouse Right-Click Feature
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You can use the Mouse Right-Click feature in order to define the Move-Resize options of the Button,
Button Shadow, Text and Text Shadow as well as to Copy-Paste State values between States. 

The Paste Special feature gives you the option to select different features you wish to copy-paste.
After selecting the features, simply click on the OK button and the changes will take effect.

  

3.14 Exporting single state web buttons

After you have finished creating your web button you will need to save it and export it in order to use it
in your website, projects, etc.

Exporting a single state button

To export your web button click on File -> Export to open the "Export" window.

After opening the "Export" window, select the directory-destination you want your button to be exported
to, the file type you want it to be exported as (.jpeg, .png, .gif), define its attributes (quality of the end
result), and click on the "Export" button. The better the quality, the bigger the file size. 

In the .png file format you also have the option of saving your button image along with an Alpha
channel in order to add transparency to your button image.

Example:
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3.15 Exporting three state buttons

Exporting Rollover (Three-State) Buttons

When Exporting a Rollover Button the files that will be created and exported will be based on the
three-states (normal, mouse over and mouse click). 

Rollover Button Export

To export your Rollover button click on the Export  button in the control panel and select the
destination and format of the file in which the button will be exported (.jpeg, .gif, .png).

42
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You may preview the Rollover button you have created by clicking on the Preview button.

Finally, when ready to export your button, simply click on the Export button. A window will open
highlighting where each of the three files (Normal, Mouse Over, Mouse Click) have been exported to
and offering you the code you will have to add to your HTML pages - JavaScript (traditional) or CSS
(no preload) options. You might want to use the Copy option to copy the entire code to your web page.
A sample html page will also be available where you will be able to see your rollover button. 
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Javascript and CSS

To achieve the mouse over and mouse click effect you need to switch between three images. The
different options to do this are the JavaScript (traditional) and CSS (no preload) options

JavaScript (traditional) option

When using JavaScript the images - basically the images for the normal, mouse over and mouse click
states -  need to be preloaded to create a rollover effect. This introduces an additional time overhead
because of the multiple HTTP requests needed. Also, certain browsers may not cache the additional
images properly resulting in loading delays.  

CSS (no preload) option

In order to reduce the time needed to display the rollover images there is the alternative based on the
CSS option which does not require preloading.

In the case of the CSS option you would be adding all states into one image that makes dynamic
changes faster. This reduces the loading time and thus the display of the rollover image itself.
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3.16 Exporting to GIF file options

GIF files use a palette (color table) of a maximum of 256 colors and an 8-bit (1 byte) index (to this
palette) per pixel. Thus, GIF images are constricted in the maximum amount of colors they can use,
which may cause image degradation.

Dithering is a technique which allows an image to approximate a wider range of colors using a limited
palette (just like in GIF files), by employing alternating patterns of pixels with different colors which get
"blended" in the eye to give the appearance of smoother color transitions. Dithering is more apparent
when using less than 8 bits per pixel. Because of the way the compression algorithm used in the GIF
file format works, dithering will increase the resulting file size.

Transparent GIF files use one of the indices in the color palette to specify a transparent color. When
the Transparent option is checked, Likno Web Button Maker will use the alpha channel of your button
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(i.e. the area around the shape of your button and text, if your text extends outside the button shape) to
set the transparent area around your button, no matter what your background image or color is.
Also bear in mind that because of the limited transparency support in the GIF format (1-bit only),
semi-transparent (anti-aliased) areas around your button may display colors between the ones in your
button and the background color (because anti-aliasing is performed between these colors). In most
cases you won't have to worry about this, unless your button has a shadow or your text extends
outside the button shape.

3.17 Exporting to PNG file options

PNG is a very versatile image file format, supporting multiple bit depths and true alpha channel
transparency.

· When selecting the 8 bit option, the resulting PNG file is similar to an 8-bit GIF with a color palette.
· When selecting the 24 bit option, there is no degradation in the image pixels (perfect quality), but the

file size will be higher than a JPEG file.
· When selecting the 32 bit option, the image is saved along with an alpha channel, which indicates

the transparent areas around your button. If you plan to use your exported images on a web page,
you should bear in mind that certain browsers (most notably Microsoft Internet Explorer 6.x or earlier
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versions) may not display your images correctly (e.g. they may display transparent areas as gray).
To work around this browser bug, we employ a popular "hack" to enable you to view these images in
Internet Explorer in the right way, too. This "hack" involves the use of a special feature of Internet
Explorer, a custom CSS attribute called "filter" as in the following example:

Use:

<div style="position:absolute; left:140px; height:32px; width:128px;
     filter:progid:DXImageTransform.Microsoft.AlphaImageLoader(
     src='image.png', sizingMethod='scale');" >
</div>

instead of:

<img src="image.png" width="128" height="32" border="0">

In the case of a 3-state button (rollover) the sample code we provide during the export process will
include the necessary code if you select the Javascript option.
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3.18 Adding links to web buttons

Through this option you will be able to add a link to your web buttons in just a few steps. 

Adding a link to your web buttons

Simply, select from the drop down menu the button you want to add a link to.

Then, define the URL link of the web page you want to link your web button to.

Finally, through the Link target options, specify the frame or window where the web page specified by
the <link> property will open.
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Values: 

Leave it blank (none) to open the <link> into the same frame or window (default for non-framed
pages). 

Choose _blank to open the <link> into a new browser window. 

Choose _top to open the <link> in the whole area of the current browser window (not to a specific
frame). 

Choose the frame name where you want the <link> to open in. If you do not use frames then just
leave this field blank OR choose _blank to open the <link> into a new browser window.

Example with Frames: 
Let's assume that we have the following Frameset Definition inside the source code of the home
page: 

<frameset framespacing="0" border="0" cols="171,*" frameborder="0"> 
<frame name="left" target="main" src="left_page.htm" scrolling="auto"> 
<frame name="main" src="main_page.htm" target="_self"> 
<noframes> 
<body> 
<p>You need a browser that supports frames to see this site </p> 
</body> 
</noframes> 
</frameset> 

Let's also assume that we have placed our button(s) at the left_page.htm page (opening at the "left"
frame). We want the buttons to open specified by their <Link> property inside the main frame. 

As we can see from the <frameset> tag, the frame where the main_page.htm opens has been
assigned the following name: 

main 

This is exactly what you need to enter into the <Link> property. Do not get confused and use the
content of the src attribute (eg: main_page); this will not work. You need to use the content of the
name attribute (eg: main). 

Adding more buttons to your selection.
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Use the "Click here to add more buttons" option in order to add more buttons to your selection. By
clicking on this option, you will be taken to the Text Tab from where you will be able to add more
buttons to your selection. Finally, go to the Links tab and add a link to each of your new buttons
accordingly.

3.19 Move-Resize Keyboard Access

Likno Web Button Maker also give you the option to manually edit the Move and Resize option.

You may Move the button, button shadow, text, and text shadow simply by locating the cursor on the
text, for example, and moving it to the desired location.

You may move and/or resize a Button based on the graphic size. In other words, you may only move
or resize a button based on the dimensions of the graphic.

The Button Shadow can be moved up to a value of 100 pixels from the top left corner of the button.

30
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The Button Text can be moved up to 100 pixels from the center of the Button and its center does not
go over the graphic size.

Finally, the Text Shadow can be moved up to 100 pixels from the text center.

You also have a Keyboard Access option, in other words, you can move and resize your button with
the following keyboard keys:

  
Move: Cursor Keys

Resize: Shift + Cursor Keys

By using the Ctrl + Shift ( + Cursor key for Resize) you will be able to apply the actions on a quicker
scale. 

By using the Tab key / Enter Key you can select an object.

3.20 Working with the FrontPage add-in

Likno Web Button Maker provides seamless integration with Microsoft FrontPage, allowing you to
insert and/or edit your buttons from within your favorite web editor.
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To insert a Likno Web Button Maker button or family of buttons in a web page from within FrontPage,
you have to have defined and opened a website first, as well as the web page where you would like
your button to be inserted into. With your web page open, click on the point where you would like your
button(s) to be inserted and select "Insert button..." from the WebButtonMaker menu (which will
normally be somewhere to the right of the Help menu). You will see this dialog:

Select "New project" to launch Likno Web Button Maker and work with a new project, or select
"Existing project" to work with a project you have already saved.
Once in Likno Web Button Maker, you will notice a new menu item in the File menu, "Export to
FrontPage":
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This menu item will only appear if you have launched Likno Web Button Maker from within FrontPage.
Once you're done with your project, click on this menu item to export your button(s) to FrontPage.

If your project contains a button family  and you choose to export the entire button family, upon
closing the export dialog you will be able to select which individual buttons from this family you would
like to export to FrontPage:

Once you click on OK, you will get a confirmation dialog and you will return to FrontPage, where you
will see your button(s) inserted into your web page.
The add-in added a copy of your Likno Web Button Maker project file in your web site root folder for
easy access, created a folder "lwbm" under your "images" folder, placed your button images there,
added the necessary HTML code for the images in the document and added a small HTML comment
just after the <body> tag, which is necessary if you would like to edit your button(s) in the future (note:
if you remove this html comment you will not be able to edit your buttons using the add-in).

3.21 Downloading Button Packs

Purchasing Likno Web Button Maker entitles you to a series of shapes found in the program which
can be used to create your buttons and to a FREE Button Pack made up of 5 completely new
shapes and presets, plus a series of ready-to-use web buttons which offers you a complete
solution!

30
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Apart from this FREE Button Pack, we have created additional sets of Button Packs with premium web
button designs which you can purchase in order to enhance your existing selection!

Example Button Shapes found in Button Packs:

Click here to view all available Button Packs

3.22 Customizing the user inteface

You can customize the look of the program's user interface by changing the position of the Pane List
tabs  or by moving the Panel itself (dock/undock) to give it a more personalized look.

· To change the position of the Panel List Tabs simply drag and drop them in the location you want.

· To move the Panel list simply drag and drop it at the upper, lower, left or right sections of the View.

Example:

8

http://www.likno.com/web-button-maker/lwbmshapes.html
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4 Commands

4.1 File

4.1.1 New

 New:  Creates a new Likno Web Button Maker file.

4.1.2 Open

 Open: Opens a Likno Web Button Maker file.

4.1.3 Close

Close: Closes an open file.

4.1.4 Save - Save As

 Save: Saves changes you have made to your existing Likno Web Button Maker file.

Save As: Saves your Likno Web Button Maker file under the file format of your choice.

4.1.5 Change to Three State

 Change to Three State: Change from single state button to three state button.

4.1.6 Change to Single State

 Change to Single State: Change from three state button to single state button.
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4.1.7 Button Factory

 Button Factory: Opens Button Factory.

4.1.8 Export

 Export: Exports your Likno Web Button Maker file under selected formats.

4.1.9 Export to FrontPage

Export to FrontPage: Exports your button(s) to FrontPage. This menu item will only appear if
the program was launched from the FrontPage add-in.

4.2 Edit

4.2.1 Undo

 Undo: Undo last action.

4.2.2 Redo

 Redo: Redo last action.

4.3 View

4.3.1 Pane List

Pane List: Shows you the available Panes for editing your web buttons.
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4.4 Help

4.4.1 Help

 Help: Search a Help Topic.

4.4.2 Help Topics

 Help Topics: Opens the Help file where you can browse/search the different topics
displayed.
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5 Likno Software

5.1 About Likno Software

Likno Software is a software development company dedicated to create quality software for
demanding web authors. Our development team is 100% Internet-oriented, focused on creating tools
that minimize your development efforts.

For technical support questions you may contact us at support@likno.com

For sales questions you may contact us at sales@likno.com

Our web site is located at http://www.likno.com

http://www.likno.com
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